Introduction to ORCAD/PSPICE Capture (versions 9.1
and 10.0) to Simulate Electronic Circuits

(As compiled by John Tucker — 13/3/2006)

The version of PSPICE available in the Labs is ORCAD version 10.0. The following
instructions are also appropriate for version 9.1 which can be downloaded on the
ELEC3400 course webpage. Please note that in the version 10.0 there is no
‘Schematics program. This is an alternative program to draw and simulate circuits
with PSPICE. Please use the ‘Capture’ program in version 9.1 to draw your circuits.
This program is compatible with the one in version 10.0.

For a more detailed explanation of other features in PSPICE go to the ‘Help’ menu in
the ‘Capture’ program and select the ‘Orcad PSpice’ option or refer to the ‘OrCAD
PSpice A/D User’s Guide’ PDFfile.

Starting a new project

* In Windows go to the Start button and then All Programs and select PSPICE or
ORCAD and then start the * Capture’ program.

* Gotothe File menu and select New and then Project

» Select the ‘Analog or Mixed A/D’ option and give a name to the project and
specify a path for the project and press ‘OK’. If you don’'t select this option then
you can’t do any simulations on your circuit.
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» Select the *Create a blank project’ option and then press ‘OK’. The *Create based

upon an existing project’ should only be used if you have aready drawn up
another schematic and want to alter it.
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* Minimise the current window (the schematic screen containing a number of dots)
and maximise the window with the extension ‘.opj” window.

* You can go to the schematic of the project at any time by expanding the ‘Design
Resources folder and then the picture folder that ends with ‘.dsn’ and then the

‘SCHEMATICY folder. Double click on the ‘PAGELl icon to go to the
schematic.
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Drawing circuits and DC simulation

The first simulation we will do isa DC or bias point smulation on a simple voltage
divider.

» First we have to put parts on the schematic. To do this go to the ‘Place’ menu on

the schematic and select ‘Part’ or aternatively select the ‘Place Part’ symbol
which isfound on the right hand side of the screen and is second from the top.
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» Different parts can be found in different libraries. You will have to click on the
‘Add Library’ button if thisis the first time that the program has been run on your
computer.

* Addall thelibraries found in the PSPICE directory if they are not there already
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*  Weneed aDC voltage source. Go to the source library and select the ‘VDC’ part.
Click ‘Place’ and use the mouse to position the component and the left mouse

button to place the part.
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» Click the right mouse button and select ‘End Mode' to stop placing the part.
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* We need to change the source voltage from OVdc to 9Vdc. There are a couple of
ways to change the properties of a part in the schematic. The ssimplest way is to
double click on the property in the schematic (ie — ‘OV’). Double click on the
voltage next to the DC source and change the property value to 9Vdc.
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* Sometimes it is hard to double click on the property value box in the schematic
because the program is stupid and selects something else. The other way to
change the property value of a part is to click once on the symbol for the part so
that it is highlighted, and then right click and select ‘Edit Properties’. You can
also double click on the part symbol to change the property value of a part.
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* You will come to the screen below. To change the DC voltage click in the box in
the ‘DC’ column. To finish changing the property values close or minimise the
window.
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* Next we need a couple of resistors for the voltage divider. Select the ‘ Place Part’
symbol and go to the ‘ANALOG’ library and select ‘R’ for resistor. You can
rotate the component while placing it by pressing ‘Ctrl-R’ or you can select the
part and go to the ‘Edit’ menu and select the ‘ Rotate’ option.
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We need to wire up the resistors so that they are in series with the DC voltage
source. You can place wires between components in the schematic by going to
the ‘Place’ menu and selecting ‘Wire' or you can click on the * Place Wire' symbol
which is found on the right hand side of the screen and is the third symbol from
the top.

Once this option is selected click on the top node of the battery then move the
mouse up so that the wire goesin a straight line and click again and then move the
mouse right so the wire goes in a straight line and click directly above the first
resistor and then move straight down and click on the node of the resistor.

At the moment the ‘Place Wire' tool is still selected so you can go to the other
nodes in the circuit and complete the wiring. To finish putting down the wires
right click and select ‘End Wire'.

If you try to wire straight from one node to the other then the program will
automatically place a wire but often this will go over other components in the
schematic or connect to other wires which you don’t want it to.

Wires are connected to other wires where there is a red dot. You can aways
delete awire or a connection point by clicking on it and pressing delete.
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You will aso need to place a ground in the circuit for the simulation to work
properly. Go to the ‘Place menu and select ‘Ground’ or click on the ‘Place
Ground’ symbol on the toolbar on the right hand side of the screen.

Go to the *‘SOURCE’ library and select the ‘0" symbol. You need to use this
ground otherwise the simulation won’'t work.
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* Place the ground on the schematic and wire it up to an appropriate part of the
circuit (like the negative terminal of the DC voltage source). It might be a good
idea to save the schematic at this point.
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*  Weare now ready to setup the simulation. There are a couple of ways you can get
to the setup screen. Y ou can go to the ‘PSpice’ menu and select * New Simulation
Profile’ or click on the ‘New Simulation Profile’ icon in the upper left hand of the
screen on the second tool bar (it looks like awindow with a star in the top left hand
corner).

* Giveaname for thesmulation like ‘DC’ and then press ‘ Create'.
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* Onthe‘Anaysis tab go to the ‘Analysis type drop down menu and select ‘Bias
Point’. At this stage we don’t want to worry about checking any of the other
boxes. Make sure the screen looks like the one below and press ‘OK’.
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You can run the smulation by going to the * PSpice’ menu and selecting ‘Run’ or
click on the ‘Play’ symbol which is on the second toolbar from the top and looks
like aplay button on a CD player.

It should open a new program called ‘PSpice A/D Demo’ with a screen that says
the ssimulation is complete. This program is usually used for graphsin other types
of simulations.

If you have any errors with your simulation then you should see what the problem
isin the bottom left hand corner of this program or you can look at the session log
details of the project by minimising the schematic window.

If you go back to the schematic you should be able to see the bias voltages at
different points on the schematic. If not go to the ‘PSpice’ menu and select ‘Bias
Points' and then ‘Enable’ and ‘Enable Bias VVoltage Display’.

Alternatively you could just click on the *V’ button on the second toolbar from the
top. You can aso display the current at each point in the circuit by clicking on the
‘I’ button and in version 10.0 you can also display the power at different points by
clicking on the “W’ button.



[¥¥/OrCAD Capture - [/ - (SCHEMATICI : PAGE1)] =1 x|
E Eile Edit Yiew Place Macro PSpice Accessories Options  Window Help = |

D|d| @ & <)o Ry ey uv.|11|1'?||§x'z|§§|ﬂyg||
tlol» (2] 2lalss [V T W)
H T 0

1 3 1 H 1

[+]

|2 2 |t <) |+ = = 8 =]

=

| [=leloldls]s %]

of
K1 [

[Ready |gitems selected [Scale=100%  ¥=3.50 Y=0.00

Bistart| S @O L HE 0P REG M H@O S BHowtouse .. |[E orcap capt.. D pictti-wi. | 8 scemanc.. | (2GS 11:23?

Time domain/transient simulation

In the next ssmulation we will look at certain voltages in the circuit at different points
in time like you would on a CRO. The advantage of PSPICE is that you can aso ook
at the current at certain partsin the circuit in the time domain (unlike a CRO).

* We will use the same circuit as above except we will replace the DC voltage
source with a voltage source that produces a sine wave at a single frequency.

» Click on the DC voltage source and delete it by pushing delete. Select the ‘Place
Part’ symbol and go to the ‘SOURCE’ library and select the ‘VSIN’ source and
place it where the DC voltage source use to be on the schematic.
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» Changethe ‘VOFF property, which represents the offset voltage, and set it to OV.
Change the ‘AMPL’ property, which represents the amplitude of the sine wave,
and setitto 1V. Finaly, changethe ‘FREQ’ property and set it to 1k (1kHz).

*  We will aso have to create or edit the ssimulation profile. Click on the ‘New
Simulation Profile’ or ‘Edit Simulation Settings' icon. Give the simulation a
meaningful name like ‘transient’ and press ‘OK’.
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* Inthe*Anaysis tab go to the ‘Analysis type drop down menu and select ‘ Time

Domain (Transient)’.

* Inthe‘Run to time box enter 4 ms. This box says how long the simulation will
go for in the time domain. The default value of 1000 ns will be too short to see a

sinewave awhole period of al

kHz sine wave.

* Then change the ‘Maximum step size' box to 0.01ms. This indicates how often
the simulation calculates the voltages and currents in the circuit. A shorter step

size will give more accurate results but will also take longer to simulate.
* Go back to the schematic and run the simulation.

The ‘PSpice A/D Demo’

program will open with a blank graph with a horizontal axis that represents the

time scale.
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* There are acouple of ways you can put circuit waveforms on the graph. Go to the
‘Trace’ menu and go to ‘Add Trace'.

* In the next window the left hand side contains the ‘ Simulation output variables'.
The variables with a ‘V’ before the brackets represent the voltage and an ‘I’

indicates the current.
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The stuff inside the brackets represents that particular point in the circuit. For

example, V(R1:1) indicates the voltage at one end of the resistor and V(R1:2)
indicates the voltage at the other end of that resistor.
* If we click on V(V2:+) and then press OK you should get a graph of the input

voltage.
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You can aso use math functions with different voltages or currents around the
circuit. For example, if we wanted to find the voltage across the resistor R1 we
could go to the ‘ Trace’ menu and ‘Add Trace’ and then click on V(R1:1) and then
‘-* option on the right hand side of the window, which lists all the

click on the *-
mathematical functions available, and then click on V(R1:2) on the left hand side

of the window.
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* You should get a trace that represents the voltage drop across the resistor. You
can delete various traces by clicking on the name of the trace below the horizontal
axis and pressing delete.
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You can also put waveforms on the graph by using voltage and current probes or
the differential voltage probe in the schematic. You can do this by clicking on the
voltage or current probe icons in the second toolbar, which look like magnifying
glasseswitha‘V’ or ‘I’ in the centre, or going to the ‘PSpice’ menu and selecting
the ‘Markers option and then the appropriate marker.

When you put the marker on the circuit make sure it is on a node of the
component and not the wire.

You can put these markers on before or after you run the ssimulation and they
should automatically appear in the * PSpice A/D Demo’ program.
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AC simulation

The last simulation we will do is an AC simulation where we will analyse different
parts of the circuit for different source voltage frequencies.

Go back to the schematic and replace the VSIN source with a VAC source in the
SOURCE library.

At the moment the circuit won't do anything for different frequencies because the
load is purely resistive. Add a 1k resistor and a 100nF capacitor in series and
connect them in parallel with the two other 1k resistors as shown in the diagram
below. The capacitor can be found in the ANALOG library with the ‘C’ symbol.
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* Usethedefault AC magnitude (1Vac) and DC offset (1Vdc) for this simulation.

» Edit or create a new simulation profile and in the ‘Anaysis tab select the ‘AC
Sweep/Noise’ option. Select the start frequency as 100 Hz and the stop frequency
as 100 kHz. If we use alogarithmic plot, which we normally do for filter transfer
functions, then set the points per decade to 10.
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» Put avoltage marker on the top node of the capacitor and run the simulation.
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* Here we can see that the AC voltage across the capacitor changes for dlfferent
frequencies due to the frequency dependent reactance of the capacitor.

* Remember that you can use the maths functions to find the 3-dB points and phase
shift by using the maths functionsin the ‘ Trace’ menu and ‘Add Trace' option.

Adding libraries/parts for other components not installed in
the demo version of PSPICE

There are only a limited number of parts available in the demo version for PSPICE.
When you click on the *Place Part’ symbol you should automatically come up with a
list of libraries. The libraries that are only on the demo for version for 9.1 of PSPICE
are ABM, ANALOG, ANALOG_P, BREAKOUT, EVAL, SOURCE, SOURCESTM
and SPECIAL. To add other libraries you will need two types of files;, one with an
.0lb extension to put the components on the schematic and one with a .lib extension to
simulate the components. A lot of libraries from different manufacturers can be found
on the Orcad Website, http://www.orcad.com/community.pspice.models.aspx. As an
example, we will use an op-amp from the Texas Instrument library (tex_inst.olb and
tex_inst.lib at the bottom of the webpage). Make sure you download or copy these
filesinto the same directory where your project will be.

» Start up anew project and select the ‘ Place Part’ symbol.
* Click the‘Add library’ button and the ‘tex_inst.olb’ library
* Select theLF353/301/T1" part and wire up the schematic below
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* Click the ‘New Simulation Profile’ icon and select a ‘ Time Domain (Transient)’
anaysis

» Put theruntime as 4 ms, and the step size as 0.01 ms.

e Don't push OK. Gotothe‘Libraries' tab.

» Select ‘Browse’ and select the ‘tex_inst.lib’ file

* Thenselect ‘Add to Design’ and then *OK’ to finish the simulation setup
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* Now click on the op-amp to highlight it and then go to the ‘Edit’ menu and select
the * PSpice model’ option.

» Thiswill open the ‘Model Editor’ program

* Click on the ‘Save' icon in the Model Editor program. (If you don’t do this the
simulation won’t work)

» Go back to the schematic screen in the Capture program and run the simulation.
This may take a little longer than the other simulations since it has to load the
model for the op-amp.

» The output voltage of the op-amp should be inverted and twice as big as the input
voltage if you have used the component values in the diagram above

Please note that you only have the student version of this program. The following
restrictions apply.

Limits
The following limits apply to the Student Version of the products:
PSpice AD
Circuit simulation is limited to circuits with up to:

« 64 nodes

« 10transistors

« 65digital primitive devices

« 10transmission linesin total (ideal or non-ideal)

« 4 pairwise coupled transmission lines.
Additional limits:

« Thesamplelibrary includes 39 analog and 134 digital parts.



Device characterization in the PSpice Model Editor islimited to diodes.
Stimulus generation in the PSpice Stimulus Editor is limited to sine waves
(analog) and clocks (digital).

Circuit optimization with the PSpice Optimizer is limited to one goal, one
parameter, and one constraint.

Y ou can not create CSDF format datafiles.

You can only display simulation data from simulations performed with the
Student Version of the simulator.

Capture

The PSpice libraries are the only ones included. The standard Capture libraries
are not included.

Import facilities, netlisters, and accessories that are not relevant to PSpice are
not included.

You can not save a design that contains more than 60 parts. (Y ou can view or
create larger designs, but you can not save them.)

Y ou can not save alibrary that contains more than 15 parts.



